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1 INTRODUCTION

1.1 CAUTIONS

CAUTION
The GPS system is operated by the government of the United States, which is solely responsible for its
accuracy and maintenance. Although the GPS 18 is a precision electronic NAVigation AID (NAVAID),
any NAVAID can be misused or misinterpreted, and therefore become unsafe. Use these products at your
own risk. To reduce the risk, carefully review and understand all aspects of these Technical Specifications
before using the GPS 18. When in actual use, carefully compare indications from the GPS to all available
navigation sources including the information from other NAVAIDs, visual sightings, charts, etc. For safety,
always resolve any discrepancies before continuing navigation.

FCC
Compliance

The GPS 18 complies with Part 15 of the FCC interference limits for Class B digital devices FOR HOME
OR OFFICE USE. These limits are designed to provide reasonable protection against harmful interference
in a residential installation, and are more stringent than “outdoor” requirements.

Operation of this device is subject to the following conditions: (1) This device may not cause harmful
interference, and (2) this device must accept any interference received, including interference that may
cause undesired operation.

This equipment generates, uses and can radiate radio frequency energy and, if not installed and used in
accordance with the instructions, may cause harmful interference to radio communications. However, there
is no guarantee that interference will not occur in a particular installation. If this equipment does cause
harmful interference to radio or television reception, which can be determined by turning the equipment off
and on, the user is encouraged to try to correct the interference by one or more of the following measures:

*  Reorient or relocate the receiving antenna.

* Increase the separation between the equipment and receiver.

e Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.
e Consult the dealer or an experienced radio/TV technician for help.

The GPS 18 does not contain any user-serviceable parts. Unauthorized repairs or modifications could result
in permanent damage to the equipment, and void your warranty and your authority to operate this device
under Part 15 regulations.
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1.2 LIMITED WARRANTY

This Garmin product is warranted to be free from defects in materials or workmanship for one year from

the date of purchase. Within this period, Garmin will at its sole option, repair or replace any components

that fail in normal use. Such repairs or replacement will be made at no charge to the customer for parts or
labor, provided that the customer shall be responsible for any transportation cost. This warranty does not

cover failures due to abuse, misuse, accident or unauthorized alteration or repairs.

THE WARRANTIES AND REMEDIES CONTAINED HEREIN ARE EXCLUSIVE AND IN LIEU OF
ALL OTHER WARRANTIES EXPRESS OR IMPLIED OR STATUTORY, INCLUDING ANY
LIABILITY ARISING UNDER ANY WARRANTY OF MERCHANTABILITY OR FITNESS FOR A
PARTICULAR PURPOSE, STATUTORY OR OTHERWISE. THIS WARRANTY GIVES YOU
SPECIFIC LEGAL RIGHTS, WHICH MAY VARY FROM STATE TO STATE.

IN NO EVENT SHALL GARMIN BE LIABLE FOR ANY INCIDENTAL, SPECIAL, INDIRECT OR
CONSEQUENTIAL DAMAGES, WHETHER RESULTING FROM THE USE, MISUSE, OR
INABILITY TO USE THIS PRODUCT OR FROM DEFECTS IN THE PRODUCT. Some states do not
allow the exclusion of incidental or consequential damages, so the above limitations may not apply to you.

Garmin retains the exclusive right to repair or replace the unit or software or offer a full refund of the
purchase price at its sole discretion. SUCH REMEDY SHALL BE YOUR SOLE AND EXCLUSIVE
REMEDY FOR ANY BREACH OF WARRANTY.

To obtain warranty service, contact your local Garmin authorized dealer. Or call Garmin Customer Service
at one of the numbers shown below, for shipping instructions and an RMA tracking number. The unit
should be securely packed with the tracking number clearly written on the outside of the package. The unit
should then be sent, freight charges prepaid, to any Garmin warranty service station. A copy of the original
sales receipt is required as the proof of purchase for warranty repairs.

Garmin International, Inc.
1200 East 151% Street
Olathe, KS 66062 U.S.A.
Telephone: 913/397.8200
FAX: 913/397.8282

Garmin (Europe) Ltd.

Unit 5, The Quadrangle, Abbey Park Industrial Estate
Romsey SO51 9DL, U.K.

Telephone: 44/1794.519944

FAX: 44/1794.519222
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1.3 OVERVIEW

The GPS 18 series products include an embedded receiver and an antenna. Based on the proven technology
found in other Garmin 12-channel GPS receivers, the GPS 18 tracks up to 12 satellites at a time while
providing fast time-to-first-fix, one-second navigation updates, and low power consumption. This
generation of GPS sensors adds the capability of FAA Wide Area Augmentation System (WAAS)
differential GPS. The GPS 18’s far-reaching capability meets the sensitivity requirements of land
navigation as well as the dynamics requirements of high-performance aircraft.

The GPS 18 design uses the latest technology and high-level circuit integration to achieve superior
performance while minimizing space and power requirements. All critical components of the system
including the RF/IF receiver hardware and the digital baseband are designed and manufactured by Garmin
to ensure the quality and capability of the GPS. The hardware capability combined with software
intelligence makes the GPS 18 easy to integrate and use.

The GPS 18 series products are designed to withstand rugged operating conditions and are waterproof to
IEC 60529 IPX7, immersion in 1 meter of water for 30 minutes. These complete GPS receivers require
minimal additional components to be supplied by an OEM or system integrator. A minimum system must
provide the GPS with a source of power and a clear view of the GPS satellites. Internal FLASH memory
allows the GPS to retain critical data such as satellite orbital parameters, last-known position, date and
time. End user interfaces such as keyboards and displays are the responsibility of the application designer.

1.4 FEATURES

*  12-channel GPS receiver tracks and uses up to 12 satellites for fast, accurate positioning and low
power consumption.

» Differential DGPS capability using real-time WAAS corrections yielding position errors of less than 3
meters.

e Compact, rugged design ideal for applications with minimal space. Receiver position information can
be displayed directly on a chartplotter or PC.

»  User initialization is not required. Once installed, unit automatically produces navigation data after
position fix is acquired.

*  User-configurable navigation mode (2-dimensional or 3-dimensional fix).

*  (GPS 18 LVC only) Highly accurate one-pulse-per-second (PPS) output for precise timing
measurements. Pulse width is configurable in 20 millisecond increments from 20 ms to 980 ms with 1
s accuracy.

*  Configurable for binary format carrier phase data output.

*  FLASH-based program and non-volatile memory. New software revisions available through Web site
download. Non-volatile memory does not require battery backup.

*  On-board rechargeable backup battery to maintain the real-time clock for up to 3 weeks.

*  Configurable parameters include expected position, current time and date, preferred position fix type
(2D, 3D, or automatic), and velocity filter time constant (none, automatic, or your choice between 2
and 255 seconds).

*  Waterproof design allows continuous exposure to the prevailing weather conditions at most locations.

GPS 18 Technical Specifications (P/N 190-00307-00) Rev. B
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1.5 GPS 18 SERIES

There are several different versions of GPS 18 available. Refer below for a list of the three major divisions
of the GPS 18 Series.

1.5.1 GPS18USB

The GPS 18 USB interfaces to a computer with an available USB port. Drivers are available for use on
Windows computers. Macintosh and Linux drivers are not available. After the drivers are loaded, the
device appears to the Windows operating system as a USB-connected device and appears in Device
Manager as a Garmin USB Device.

1.5.2 GPS18PC

The GPS 18 PC interfaces to a serial port of a computer via a DB-9 connector and receives power through a
12-volt cigarette lighter adapter. The unit accepts TIA-232-F (RS-232) level inputs and transmits voltage
levels that swing from zero V (ground) to 5 V TIA-232-F (RS-232) polarity.

The GPS 18 PC can cause an issue with Windows operating systems if the DB9 connector is plugged into
the computer before the navigation software is up and running. The Windows operating system may
interpret the serial connector on the GPS 18 as a serial mouse. Please refer to Appendix C: GPS 18
PC/LVC and Windows Serial Mouse Issue for complete details.

1.5.3 GPS18LVC

The GPS 18 LVC interfaces to a serial port. The unit accepts TIA-232-F (RS-232) level inputs and
transmits voltage levels that swing from ground to the positive supply voltage, TIA-232-F (RS-232)
polarity. GPS 18 LVC also has reverse polarity protection. The cable contains wires for power, ground,
receive, transmit, and pulse per second.

At the end of the cable, the wires are terminated in a connector that is used by Garmin for testing purposes.
Most customers will remove this connector and replace it with another connector of their own choosing.
Removing the factory installed connector and/or replacing with another customer-supplied connector will
have no affect on the warranty (see section 1.2 Limited Warranty). The factory-installed connector will
mate with JST right-angle PCB-mount connector (model BM06B-SRSS-TBT) or side-entry PCB-mount
connector (model SM06B-SRSS-TB). You may obtain technical information on these PCB-mount mating
connectors from the JST Web site: http://www.jst.con/.

GPS 18 Technical Specifications (P/N 190-00307-00) Rev. B
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1.6 TECHNICAL SPECIFICATIONS

Specifications are subject to change without notice.

1.6.1 Physical Characteristics
1.6.1.1 Size

61mm in diameter and 19.5mm in height.
1.6.1.2 Weight

* GPS 18 USB: 100.4g

* GPS 18 PC: 184.6g

* GPS18LVC: 115.6g

1.6.1.3 Color
Black

1.6.1.4 Case Material
Polycarbonate thermoplastic that is waterproof to IEC 60529 IPX7 level (immersion in 1 meter of water for
30 minutes)

1.6.1.5 Cable Length
e GPS 18 USB: 2 meter
e GPS 18 PC: 2 meter
e GPS 18 LVC: 3 meter

1.6.2 Electrical Characteristics

1.6.2.1 Input Voltage
GPS 18 USB: 4.4 — 5.5V

GPS I8 PC: 8 -30V (Automotive supply from cigarette lighter jack)
GPS 18 LVC:4.0-5.5V

1.6.2.2 Input Current
* GPS 18 USB: 55SmA @ 5.0V

GPS 18 PC: 50mA @ 13.8V
GPS 18 LVC: 60mA @ 5.0V

1.6.2.3 CMOS Serial Output Levels
e GPS 18 PC: 0V to 5V (Asynchronous Serial, TIA-232-F (RS-232) Compatible Polarity)

e GPS 18 LVC: 0V to Vin, between 4 and 5.5 V (Asynchronous Serial, TIA-232-F (RS-232) Compatible
Polarity)

1.6.2.4 GPS Receiver Sensitivity
-165 dBW minimum

1.6.3 Environmental Characteristics
e Operating Temperature: -30°C to +80°C

e Storage Temperature:  -40°C to +90°C

GPS 18 Technical Specifications (P/N 190-00307-00) Rev. B
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1.6.4 GPS Performance

1.6.4.1 Receiver
WAAS enabled; 12 parallel channel GPS receiver continuously tracks and uses up to 12 satellites (up to 11
with PPS active) to compute and update your position.

1.6.4.2 Acquisition Times
Reacquisition: Less than 2 seconds

Warm:

Cold:

Approx. 15 seconds (all data known)

Approx. 45 seconds (initial position, time, and almanac known; ephemeris unknown)

AutoLocate™: 5 minutes (almanac known; initial position and time unknown)

SkySearch:

5 minutes (no data known)

1.6.4.3 Update Rate
1 record per second

1.6.4.4 Accuracy
GPS Standard Positioning Service (SPS)

Position:
Velocity:
WAAS
Position:
Velocity:
PPS Time:
Dynamics:

< 15 meters, 95% typical
0.1 knot RMS steady state

< 3 meters, 95% typical

0.1 knot RMS steady state

+1 microsecond at rising edge of PPS pulse

999 knots velocity (only limited at altitude greater than 60,000 feet), 6g dynamics
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1.6.5 Interfaces
1.6.5.1 GPS 18 Electrical Characteristics

e GPS 18 USB: USB 2.0 full-speed protocol compatible (as well as USB 1.1 full-speed protocol)
e GPS 18 PC and LVC: TIA-232-F (RS-232) compatible asynchronous receiver. Default setting is 4800
baud.

1.6.5.2 GARMIN Interface and GARMIN USB Protocol

Refer to the GARMIN GPS Interface Specification USB Addendum for specific information about the
GARMIN USB Protocol. The document is located on the Garmin Web site at:
http://www.garmin.com/support/commProtocol.html. See also Appendix B: Binary Phase Output Format
for additional information concerning access to raw pseudo-range and carrier phase data from the GPS 18
USB.

Refer to the GARMIN GPS Interface Specification for details on the GARMIN interface. At the time of this
printing, these specs are available from the technical suppport section of our Web site:

http://www.garmin.com/support/commProtocol.html.

1.6.5.3 GPS 18 PC and GPS 18 LVC Protocols

* NMEA 0183 Version 2.0 or NMEA 0183 Version 2.30 (Version 2.0 is factory default, programmable
by data field 7 of the PGRMCI1 sentence described in Section 4.1.4 Additional Sensor Configuration
Information (PGRMCI).

e Available NMEA 0183 output sentences include GPALM, GPGGA, GPGSA, GPGSV, GPRMC,
GPVTG, GPGLL, PGRME, PGRMF, PGRMT, PGRMV, and PGRMB (GARMIN proprietary
sentences). See Section 4.2 Transmitted NMEA 0183 Sentences for format descriptions.

*  Configuration and initialization is accomplished with NMEA 0183 input sentences. Allows
initialization of information such as expected position, date, time, earth datum, and differential mode.
See Section 4.1 Received NMEA 0183 Sentences for format descriptions.

*  Configurable for binary data output including GPS carrier phase data

1.6.5.4 PPS (GPS 18 LVC only)

* 1 Hz pulse with programmable width, configurable in 20ms increments form 20ms to 980ms (See
Section 4.1.3 Sensor Configuration Information (PGRMC) for details on configuring the GPS 18
LVC’s handling of the PPS feature)

* 1 Ys accuracy for all conditions in which the GPS 18 LVC has reported a valid and accurate position
fix for at least the previous 4 seconds
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2 GPS 18 LVC WIRING AND PINOUTS

The GPS 18 LVC interfaces to a serial port. The unit accepts TIA-232-F (RS-232) level inputs and
transmits voltage levels from ground to the input voltage, TIA-232-F (RS-232) polarity.

The GPS 18 LVC wires are terminated with a six-wire connector that is used by Garmin for testing
pruposes. You can remove this connector without voiding your warranty (see section 1.2 Limited

Warranty).
2.1 GPS 18 LVC PINOUT
GPS 18 Pin # Color Signal Name Wire Gauge
1 Yellow PPS 28
2 Red Vin 26
3 Black Ground 28
4 White Transmit Data 28
5 Black Ground 26
6 Green Receive Data 28
Table 1: GPS 18 LVC Wire Pinout
2.2 GPS 18 LVC WIRING DIAGRAMS
85— GPS 18LVC
fuse  Computer Serial Port

Power Source

Serial Connector
(Female Pin Contacts)

Interconnection
o ol1) Yellow: PPS
Pin 5: Ground (2) Red: Vin
p (3) Black: GND
Pin 3: Data Out _ _ B (4) White: TXD
Pin 2: Data In ><: (5) Black: GND (Drain Wire)
TN (6) Green: RCV
DB-9

Figure 1: Computer Serial Port Interconnection
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G

Power Source

GPS 18LVC
% PDA Serial Port

Serial Connector
(Male Pin Contacts)

Interconnection
_(1) Yellow: PPS
" (2) Red: Vin
Pin 2: Data Out - 4 (3) Black: GND
ie A - (4) White: TXD
gr‘l 3: gata Ir; b (5) Black: GND (Drain Wire)
in 5: Groun > (6) Green: RCV
DB-9

Figure 2. PDA Serial Port Interconnection

)

Power Source

+)

Fuse

A GPS 18LVC

Basic Interconnection

POWER _ (1) Yellow: PPS
. . (2) Red: Vin
GROUND
Host Appllca_tlon 1 @ BeckanD
NMEA Device DATA OUT N (4) White: TXD
DATA IN _>< (5) Black: GND (Drain Wire)
(6) Green: RCV

j L 4

Figure 3. Basic NMEA Device Interconnection
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3 MECHANICAL CHARACTERISTICS & MOUNTING

The central threaded recess accepts a metric M3 threaded bolt. The recess is approximately 4 mm deep
(4.32 +/- .08 mm). The following drawings show example geometries for mounting hardware in case you
wish to design your own custom mount. Figure 5 shows mounting geometry for a mount formed from steel
sheet metal that is 1.15 mm thick. Figure 7 shows similar mounting geometry for mount formed from
aluminum sheet metal that is 1.25 mm thick. Use caution when tightening the mounting bolt. Tightening
the mounting bolt can cause the mount to pull tight directly against the metal insert, not against the plastic
housing, which would tend to pull the insert out of the plastic. Figure 6 shows the dimensions of our GPS
18 Flush Mount, part number 010-10453-00.

10.00 -

UNITS: MILLIMETERS
Figure 4a. GPS 18 Bottom Case Dimensions, Under mold

I~ ?9.00

©6.98

Figure 4b. GPS 18 Bottom Case, Outside of Casing
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Figure 5. GPS 18 Suction Cup Mount Center Hole Dimensions

C'SINK 90 °
4%
©$5.80
4x
45°
4}{\

Figure 6. GPS 18 Flush Mount Dimensions
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<9°°> \R]j 1.75
0= —#—[
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«——— (20.78 ——
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Dimension units: mm
Figure 7. GPS 18 Flush Mount Center Hole Dimensions
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4 GPS 18 PC AND GPS 18 LVC SOFTWARE INTERFACE

The interface protocol design of the GPS 18 PC and LVC products is based on the National Marine
Electronics Association’s NMEA 0183 ASCII interface specification. This standard is fully defined in
NMEA 0183, Version 2.30. Copies may be obtained from NMEA, www.nmea.org.

In addition to the standard NMEA 0183 sentences, the GPS 18 PC and GPS 18 LVC may also be
configured to transmit information over their serial interface using NMEA 0183 compliant Garmin
proprietary sentences. These proprietary sentences begin with the characters, “SPGRM”, instead of the
characters “$G” that are typical of the standard NMEA 0183 sentences. The characters “$P” indicate that
the sentence is a proprietary implementation and the characters and “GRM?” indicate that it is Garmin’s
proprietary sentence. The letter (or letters) that follow the characters “$PGRM” uniquely identifies that
particular Garmin proprietary sentence.

It is also possible to configure the GPS 18 PC or GPS 18 LVC to transmit binary phase data information
over their serial interface. See Appendix B: Binary Phase Output Format for details.

The GPS 18 USB does not transmit NMEA sentences: It transmits using the GARMIN USB interface. The
GARMIN USB interface is discussed in the GARMIN GPS Interface Specification USB Addendum located
on the Garmin Web site at: http://www.garmin.com/support/commProtocol.html. You can configure the
GPS 18 USB to transmit binary phase data information over the USB interface. Refer to Appendix B:
Binary Phase Output Format.

The following sections describe the NMEA 0183 data format of each sentence transmitted and received by
the GPS 18 PC and LVC products.

4.1 RECEIVED NMEA 0183 SENTENCES

The following paragraphs define the sentences that can be received on the GPS sensors’ port. Null fields in
the configuration sentence indicate no change in the particular configuration parameter. All sentences
received by the GPS sensor must be terminated with <CR><LF>, the ASCII characters for carriage return
(0D hexadecimal) and line feed (OA hexadecimal). The checksum *hh is used for parity checking data and
is not required, but is recommended for use in environments containing high electromagnetic noise. It is
generally not required in normal PC environments. When used, the parity bytes (hh) are the ASCII
representation of the exclusive-or (XOR) sum of all the characters between the “$” and “*” characters, non-
inclusive. The hex representation must be a capital letter, such as 3D instead of 3d. Sentences may be
truncated by <CR><LF> after any data field and valid fields up to that point will be acted on by the sensor.

4.1.1 Almanac Information (ALM)

The SGPALM sentence can be used to initialize the GPS sensor’s stored almanac information in the
unlikely event of non-volatile memory loss or after storing longer than six months without tracking GPS
satellites.

$GPALM,<1>,<2> <3>,<4> <5> <6>,<7>,<8> <9> <10>,<1 1>,<12>,<13>,<14>,<15>*hh<CR><LF>

This field can be null or any number when sending almanac to the GPS sensor.

<1> | Total number of ALM sentences to be transmitted by the GPS sensor during almanac download.

<2> | Number of current ALM sentence. This field can be null or any number when sending almanac
to the GPS sensor.

<3> | Satellite PRN number, 01 to 32

<4> | GPS week number

<5> | SV health, bits 17-24 of each almanac page

<6> | Eccentricity

<7> | Almanac reference time

<8> | Inclination angle

<9> | Rate of right ascension

<10> | Root of semi major axis

<11> | Omega, argument of perigee

<12> | Longitude of ascension node

<13> | Mean anomaly

<14> | af0 clock parameter

<15> | afl clock parameter
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4.1.2 Sensor Initialization Information (PGRMI)

The $PGRMI sentence provides information used to initialize the GPS sensor’s set position and time used
for satellite acquisition. Receipt of this sentence by the GPS sensor causes the software to restart the
satellite acquisition process. If there are no errors in the sentence, it will be echoed upon receipt. If an error
is detected, the echoed PGRMI sentence will contain the current default values. Current PGRMI defaults
(with the exception of the Receiver Command, which is a command rather than a mode) can also be
obtained by sending $PGRMIE to the GPS sensor.

$PGRMI,<1>,<2>,<3> <4>,<5>,<6>,<7>*hh<CR><LF>

<1> | Latitude, ddmm.mmm format (leading zeros must be transmitted)
<2> | Latitude hemisphere, N or S

<3> | Longitude, dddmm.mmm format (leading zeros must be transmitted)
<4> | Longitude hemisphere, E or W

<5> | Current UTC date, ddmmyy format

<6> | Current UTC time, hhmmss format

<7> | Receiver Command, A = Auto Locate, R = Unit Reset

4.1.3 Sensor Configuration Information (PGRMC)

The $PGRMC sentence provides information used to configure the GPS sensor’s operation. Configuration
parameters are stored in non-volatile memory and retained between power cycles. The GPS sensor will
echo this sentence upon its receipt if no errors are detected. If an error is detected, the echoed PGRMC
sentence will contain the current default values. Current default values can also be obtained by sending
$PGRMCE to the GPS sensor.

$PGRMC,<1>,<2>,<3>,<4> <5> <6>,<7>,<8><9> <10>,<1 1>,<12>,<13>,<14>*hh<CR><LF>

<1> | Fix mode, A = automatic, 2 = 2D exclusively (host system must supply altitude),
3 =3D exclusively

<2> | Altitude above/below mean sea level, -1500.0 to 18000.0 meters

<3> | Earth datum index. If the user datum index (96) is specified, fields <4> through <8> must
contain valid values. Otherwise, fields <4> through <8> must be null. Refer to Appendix A:
Earth Datums for a list of earth datums and the corresponding earth datum index.

<4> | User earth datum semi-major axis, 6360000.000 to 6380000.000 meters (.001 meters
resolution)

<5> | User earth datum inverse flattening factor, 285.0 to 310.0 (10~ resolution)

<6> | User earth datum delta x earth centered coordinate, -5000.0 to 5000.0 meters (1 meter

resolution)

<7> | User earth datum delta y earth centered coordinate, -5000.0 to 5000.0 meters (1 meter
resolution)

<8> | User earth datum delta z earth centered coordinate, -5000.0 to 5000.0 meters (1 meter
resolution)

<9> | Differential mode, A = automatic (output DGPS data when available, non-DGPS otherwise), D
= differential exclusively (output only differential fixes)

<10> | NMEA 0183 Baud rate, 1 = 1200, 2 = 2400, 3 = 4800, 4 = 9600, 5 = 19200, 6 = 300, 7 = 600

<11> | Velocity filter, 0 = No filter, 1 = Automatic filter, 2-255 = Filter time constant (e.g., 10 = 10
second filter)

<12> | PPSmode, ] =No PPS,2=1Hz

<13> | PPS pulse length, 0-48 = (n+1)*20 ms. Example: n =4 corresponds to a 100 ms wide pulse

<14> | Dead reckoning valid time 1-30 (sec)

All configuration changes take effect after receipt of a valid value except baud rate and PPS mode. Baud
rate and PPS mode changes take effect on the next power cycle or an external reset event.
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4.1.4 Additional Sensor Configuration Information (PGRMC1)

The $PGRMCI1 sentence provides additional information used to configure the GPS sensor operation.
Configuration parameters are stored in non-volatile memory and retained between power cycles. The GPS
sensor will echo this sentence upon its receipt if no errors are detected. If an error is detected, the echoed
PGRMCI sentence will contain the current default values. Current default values can also be obtained by
sending $PGRMCIE to the GPS sensor.

$PGRMC1,<1>,<2>,<3>,<4> <5> <6>,<7>,<8>,<9>*hh<CR><LF>

<1> | NMEA 0183 output time 1-900 (sec)

<2> | Binary Phase Output Data, 1 = Off, 2 = On.

<3> | Automatic Position Averaging when Stopped, 1 = Off, 2 =0n

<4> | No Effect (DGPS beacon frequency — 0.0, 283.5 — 325.0 kHz in 0.5 kHz steps)

<5> | No Effect (DGPS beacon bit rate — 0, 25, 50, 100, or 200 bps)

<6> | No Effect (DGPS beacon scanning, 1 = Off, 2 = On)

<7> | NMEA 0183 version 2.30 mode indicator, 1 = Off, 2 = On

<8> | DGPS mode, W = WAAS Only, N = None (DGPS disabled)

<9> | Power Save Mode, P = Power Save mode, N = Normal

Configuration changes take effect immediately, with the exception of Binary Phase Output Data, which
takes effect on the next power cycle or a reset event. A reset can be commanded by sending the sentence
“$PGRML,,.,,,,R” (refer to Section 4.1.2 Sensor Initialization Information (PGRMI)). If the GPS sensor is
in the Binary data mode, it is necessary to send the following eight-byte data stream to temporarily change
the data format to NMEA 0183. Then follow by sending a PGRMCI1 sentence that turns off the Binary
Phase Output Data format:

10 0A 02 26 00 CE 10 03 (Hexadecimal)

4.1.5 Output Sentence Enable/Disable (PGRMO)
The SPGRMO sentence provides the ability to enable and disable specific output sentences. The following
sentences are enabled at the factory: GPGGA, GPGSA, GPGSV, GPRMC, and PGRMT.

$PGRMO,<1>,<2>*hh<CR><LF>

<1> | Target sentence description (e.g., PGRMT, GPGSV, etc.)

<2> | Target sentence mode, where:

0 = disable specified sentence

1 = enable specified sentence

2 = disable all output sentences

3 = enable all output sentences (except GPALM)
4 = restore factory default output sentences

The following notes apply to the PGRMO input sentence:

1. If the target sentence mode is ‘2’ (disable all), ‘3* (enable all), or ‘4’ (restore defaults), the target
sentence description is not checked for validity. In this case, an empty field is allowed (e.g.,
$PGRMO,,3), or the mode field may contain from 1 to 5 characters.

2. If the target sentence mode is ‘0’ (disable) or ‘1’ (enable), the target sentence description field must be
an identifier for one of the sentences that can be output by the GPS sensor.

3. [Ifeither the target sentence mode field or the target sentence description field is not valid, the PGRMO
sentence will have no effect.

4. $PGRMO,GPALM,1 will cause the GPS sensor to transmit all stored almanac information. All other
NMEA 0183 sentence transmission will be temporarily suspended.

5. $PGRMO,,G will cause the COM port to change to GARMIN Data Transfer format for the duration of
the power cycle. The GARMIN mode is required for GPS 18 series product software updates.
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4.2 TRANSMITTED NMEA 0183 SENTENCES

The subsequent paragraphs define the sentences that can be transmitted by the GPS 18 PC and LVC.

4.2.1 Sentence Transmission Rate
Sentences are transmitted with respect to the user selected baud rate.

The GPS sensor will transmit each sentence (except where noted in particular transmitted sentence

descriptions) at a periodic rate based on the user selected baud rate and user selected output sentences. The

GPS sensor will transmit the selected sentences contiguously. The length of the transmission can be

determined by the following equation and Tables 2 and 3:

length of transmission

total characters to be transmitted

characters transmitted per second

Sentence | Output by Default? Maximum Characters
GPRMC g 74
GPGGA 0 82
GPGSA 0 66
GPGSV 0 70
PGRME 0 35
GPGLL 44
GPVTG 42
PGRMV 32
PGRMF 82
PGRMB 0 40
PGRMT Once per minute 50

Table 2: NMEA 0183 Output Sentence Order and Size

Baud Characters per Second
300 30
600 60

1200 120

2400 240

4800 480

9600 960

19200 1920

38400 3840

Table 3: Characters per Second for Available Baud Rates

The maximum number of fields allowed in a single sentence is 82 characters including delimiters. Values
in the table include the sentence start delimiter character “$” and the termination delimiter <CR><LF>. The

factory set defaults will result in a once per second transmission at the NMEA 0183 specification

transmission rate of 4800 baud.

Regardless of the selected baud rate, the information transmitted by the GPS sensor is referenced to the
one-pulse-per-second output pulse immediately preceding the GPRMC sentence, or whichever sentence is
output first in the burst (see Table 2 above).
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4.2.2 Transmitted Time

The GPS sensor outputs UTC (Coordinated Universal Time) date and time of day in the transmitted
sentences. Before the initial position fix, the on-board clock provides the date and time of day. After the
initial position fix, the date and time of day are calculated using GPS satellite information and are
synchronized with the one-pulse-per-second output.

The GPS sensor uses information obtained from the GPS satellites to add or delete UTC leap seconds and
correct the transmitted date and time of day. The transmitted date and time of day for leap second
correction follow the guidelines in “National Institute of Standards and Technology Special Publication
432 (Revised 1990)” (for sale by the Superintendent of Documents, U.S. Government Printing Office,
Washington, D.C., 20402, U.S.A.).

When a positive leap second is required, one second is inserted at the beginning of the first hour (Oh Om 0s)
of the day that the positive leap is occurring. The minute containing the leap second is 61 seconds long. The
GPS sensor would have transmitted this information for the leap second added December 31, 1998 as
follows:

$GPRMC,235959,A,3851.3651,N,09447.9382,W,000.0,221.9,071103,003.3,E*69
$GPRMC,000000,A,3851.3651,N,09447.9382,W,000.0,221.9,081103,003.3,E*67
$GPRMC,000000,A,3851.3651,N,09447.9382,W,000.0,221.9,081103,003.3,E*67
$GPRMC,000001,A,3851.3651,N,09447.9382,W,000.0,221.9,081103,003.3,E*66

If a negative leap second should be required, one second will be deleted at the end of some UTC month.
The minute containing the leap second will be only 59 seconds long. In this case, the GPS sensor will not
transmit the time of day Oh Om Os (the “zero” second) for the day from which the leap second is removed.

$GPRMC,235959,A,3851.3650,N,09447.9373,W,000.0,000.0,111103,003.3,E*69
$GPRMC,000001,A,3851.3650,N,09447.9373,W,000.0,000.0,121103,003.3,E*¥*6A
$GPRMC,000002,A,3851.3650,N,09447.9373,W,000.0,000.0,121103,003.3,E*69

4.2.3 Global Positioning System Almanac Data (ALM)

Almanac sentences are not normally transmitted. Almanac transmission can be initiated by sending the
GPS sensor a SPGRMO,GPALM,1 command. Upon receipt of this command, the GPS sensor will transmit
available almanac information on GPALM sentences. During the transmission of almanac sentences, other
NMEA 0183 data output will be temporarily suspended.

$GPALM,<1><2>,<3> <4> <5> <6>,<7>,<8> <9> <10> <1 1> <12>,<13>,<14>,<1 5>*hh<CR><LF>
<field information> can be found in Section 4.1.1 Almanac Information (ALM).

4.2.4 Global Positioning System Fix Data (GGA)
$GPGGA <1>,<2>,<3>,<4> <5>,<6>,<7>,<8>,<9> M,<10>M,<1 1>,<12>*hh<CR><LF>

<1> | UTC time of position fix, hhmmss format

<2> | Latitude, ddmm.mmmm format (leading zeros will be transmitted)

<3> | Latitude hemisphere, N or S

<4> | Longitude, dddmm.mmmm format (leading zeros will be transmitted)

<5> | Longitude hemisphere, E or W

<6> | GPS quality indication, 0 = fix not available, 1 = Non-differential GPS fix available, 2 =
Differential GPS (DGPS) fix available, 6 = Estimated

<7> | Number of satellites in use, 00 to 12 (leading zeros will be transmitted)

<8> | Horizontal dilution of precision, 0.5 to 99.9

<9> | Antenna height above/below mean sea level, -9999.9 to 99999.9 meters

<10> | Geoidal height, -999.9 to 9999.9 meters

<11> | Differential GPS (RTCM SC-104) data age, number of seconds since last valid RTCM
transmission (null if not an RTCM DGPS fix)

RTCM DGPS fix)

<12> | Differential Reference Station ID, 0000 to 1023 (leading zeros will be transmitted, null if not an
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4.2.5 GPS DOP and Active Satellites (GSA)

$GPGSA <1>,<2>,<3>,<3>,<3>,<3>,<3>,<3>,<3>,<3>,<3>,<3> <3> <3> ,<4> ,<5> <6>*hh<CR><LF>

<1> | Mode, M = manual, A = automatic

<2> | Fix type, 1 = not available, 2 =2D, 3 =3D

<3> | PRN number, 01 to 32, of satellite used in solution, up to 12 transmitted (leading zeros will be
transmitted)

<4> | Position dilution of precision, 0.5 to 99.9

<5> | Horizontal dilution of precision, 0.5 to 99.9

<6> | Vertical dilution of precision, 0.5 to 99.9

4.2.6 GPS Satellites in View (GSV)
$GPGSV <1>,<2>,<3> <4> <5>,<6>,<7>,...<4> <5>,<6>,<7>*hh<CR><LF>

<1> | Total number of GSV sentences to be transmitted

<2> | Number of current GSV sentence

<3> | Total number of satellites in view, 00 to 12 (leading zeros will be transmitted)

<4> | Satellite PRN number, 01 to 32 (leading zeros will be transmitted)

<5> | Satellite elevation, 00 to 90 degrees (leading zeros will be transmitted)

<6> | Satellite azimuth, 000 to 359 degrees, true (leading zeros will be transmitted)

<7> | Signal to noise ratio (C/No) 00 to 99 dB, null when not tracking (leading zeros will be
transmitted)

NOTE: Items <4>,<5><6>, and <7> repeat for each satellite in view to a maximum of four (4) satellites
per sentence. Additional satellites in view information must be sent in subsequent bursts of NMEA 0183
data. These fields will be null if unused.

4.2.7 Recommended Minimum Specific GPS/TRANSIT Data (RMC)
$GPRMC,<1>,<2> <3> <4> <5> <6>,<7><8> <9> <10>,<11>,<12>*hh<CR><LF>

<1> | UTC time of position fix, hhmmss format

<2> | Status, A = Valid position, V =NAYV receiver warning

<3> | Latitude, ddmm.mmmm format (leading zeros will be transmitted)

<4> | Latitude hemisphere, N or S

<5> | Longitude, dddmm.mmmm format (leading zeros will be transmitted)

<6> | Longitude hemisphere, E or W

<7> | Speed over ground, 000.0 to 999.9 knots (leading zeros will be transmitted)

<8> | Course over ground, 000.0 to 359.9 degrees, true (leading zeros will be transmitted)

<9> | UTC date of position fix, ddmmyy format

<10> | Magnetic variation, 000.0 to 180.0 degrees (leading zeros will be transmitted)

<11> | Magnetic variation direction, E or W (westerly variation adds to true course)

<12> | Mode indicator (only output if NMEA 0183 version 2.30 active), A = Autonomous,
D = Differential, E = Estimated, N = Data not valid

4.2.8 Track Made Good and Ground Speed (VTG)
$GPVTG,<1>,T,<2>M,<3>N,<4> K ,<5>*hh<CR><LF>

<1> | True course over ground, 000 to 359 degrees (leading zeros will be transmitted)
<2> | Magnetic course over ground, 000 to 359 degrees (leading zeros will be transmitted)
<3> | Speed over ground, 000.0 to 999.9 knots (leading zeros will be transmitted)
<4> | Speed over ground, 0000.0 to 1851.8 kilometers per hour (leading zeros will be transmitted)
<5> | Mode indicator (only output if NMEA 0183 version 2.30 active), A = Autonomous,
D = Differential, E = Estimated, N = Data not valid
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4.2.9 Geographic Position (GLL)
$GPGLL,<1>,<2>,<3>,<4> <5> <6>,<7>*hh<CR><LF>

<1> | Latitude, ddmm.mmmm format (leading zeros will be transmitted)

<2> | Latitude hemisphere, N or S

<3> | Longitude, dddmm.mmmm format (leading zeros will be transmitted)

<4> | Longitude hemisphere, E or W

<5> | UTC time of position fix, hhmmss format

<6> | Status, A = Valid position, V = NAV receiver warning

<7> | Mode indicator (only output if NMEA 0183 version 2.30 active), A = Autonomous,
D = Differential, E = Estimated, N = Data not valid

4.2.10 Estimated Error Information (PGRME)
$PGRME,<1>M,<2> M,<3> M*hh<CR><LF>

<1> | Estimated horizontal position error (HPE), 0.0 to 999.9 meters

<2> | Estimated vertical position error (VPE), 0.0 to 999.9 meters

<3> | Estimated position error (EPE), 0.0 to 999.9 meters

4.2.11 GPS Fix Data Sentence (PGRMF)
$PGRMF, <1><2> <3> <4> <5> <6> <7>,<8> <9> <10>,<11>,<12> <13>,<14> <1 5>*hh<CR><LF>

<1> | GPS week number (0 - 1023)

<2> | GPS seconds (0 - 604799)

<3> | UTC date of position fix, ddmmyy format

<4> | UTC time of position fix, hhmmss format

<5> | GPS leap second count

<6> | Latitude, ddmm.mmmm format (leading zeros will be transmitted)

<7> | Latitude hemisphere, N or S

<8> | Longitude, dddmm.mmmm format (leading zeros will be transmitted)

<9> | Longitude hemisphere, E or W

<10> | Mode, M = manual, A = automatic

<11> | Fix type, 0 =no fix, 1 =2D fix, 2 = 3D fix

<12> | Speed over ground, 0 to 1851 kilometers/hour

<13> | Course over ground, 0 to 359 degrees, true

<14> | Position dilution of precision, 0 to 9 (rounded to nearest integer value)

<15> | Time dilution of precision, 0 to 9 (rounded to nearest integer value)

4.2.12 Sensor Status Information (PGRMT)
The GARMIN Proprietary sentence SPGRMT gives information concerning the status of the GPS sensor.
This sentence is transmitted once per minute regardless of the selected baud rate.

$PGRMT, <1>,<2>,<3>,<4> <5> <6>,<7>,<8> <9>*hh<CR><LF>

<1> | Product, model and software version (variable length field, e.g., “GPS 18 VER 2.05™)

<2> | ROM checksum test, P = pass, F = fail

<3> | Receiver failure discrete, P = pass, F = fail

<4> | Stored data lost, R = retained, L = lost

<5> | Real time clock lost, R = retained, L = lost

<6> | Oscillator drift discrete, P = pass, F = excessive drift detected

<7> | Data collection discrete, C = collecting, null if not collecting

<8> | GPS sensor temperature in degrees C

<9> | GPS sensor configuration data, R = retained, L = lost

4.2.13 3D velocity Information (PGRMV)
$PGRMV <1>,<2> <3>*hh<CR><LF>

<1> | True east velocity, 514.4 to 514.4 meters/second

<2> | True north velocity, 514.4 to 514.4 meters/second

<3> | Up velocity, 999.9 to 9999.9 meters/second
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4.2.14 DGPS Beacon Information (PGRMB)
NOTE: PGRMB is not supported at this time.

$PGRMB,<1>,<2>,<3> <4> <5> K ,<6>,<7>*hh<CR><LF>

<1> | Beacon tune frequency, 0.0, 283.5 — 325.0 kHz in 0.5 kHz steps

<2> | Beacon bit rate, 0, 25, 50, 100, or 200 bps

<3> | Beacon SNR, 0 to 31

<4> | Beacon data quality, 0 to 100

<5> | Distance to beacon reference station in kilometers

<6> | Beacon receiver communication status (0 = Check Wiring, 1 = No Signal, 2 = Tuning, 3 =
Receiving, 4= Scanning)

<7> | DGPS fix source (R = RTCM, W = WAAS, N = Non-DGPS Fix)

<8> | DGPS mode, A = Automatic, W = WAAS Only, R = RTCM Only, N = None (DGPS disabled)

4.3 BAUD RATE SELECTION

Baud rate selection can be performed by sending the appropriate configuration sentence to the GPS sensor
as described in the SPGRMC Section 4.1.2 Sensor Initialization Information (PGRMI), field <10>.

4.4 ONE-PULSE-PER-SECOND (PPS) OUTPUT (GPS 18 LVC ONLY)

The highly accurate one-pulse-per-second (PPS) output is provided for applications requiring precise
timing measurements. The signal is generated after the initial position fix has been calculated and continues
until power down. The rising edge of the signal is aligned to the start of each GPS second within 1 ps for
all conditions in which the receiver has reported a valid and accurate position for at least the previous 4
seconds.

The NMEA 0183 sentences that follow each rising edge of the PPS signal tell when you were and where
you were at that previous rising edge of the PPS signal, beginning with the GPRMC sentence as the lead
sentence in any particular NMEA 0183 record.

Regardless of the selected baud rate, the information transmitted by the GPS 18 series products is
referenced to the pulse immediately preceding the NMEA 0183 RMC sentence.

The accuracy of the one-pulse-per-second output is maintained only while the GPS 18 series products can
compute a valid position fix. To obtain the most accurate results, the one-pulse-per-second output should be
calibrated against a local time reference to compensate for cable and internal receiver delays and the local
time bias.

The default pulse width is 100 ms, however; it may be programmed in 20 ms increments between 20 ms
and 980 ms as described in $PGRMC Section 4.1.2 Sensor Initialization Information (PGRMI), field <13>.
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APPENDIX A: EARTH DATUMS

The following is a list of the Garmin GPS 18 Earth datum indices and the corresponding earth datum name
(including the area of application):

0 ADINDAN - Ethiopia, Mali, Senegal, Sudan

1 AFGOOYE - Somalia

2 AIN EL ABD 1970 - Bahrain Island, Saudi Arabia

3 ANNA 1 ASTRO 1965 - Cocos Island

4 ARC 1950 - Botswana, Lesotho, Malawi, Swaziland, Zaire, Zambia, Zimbabwe

5 ARC 1960 - Kenya, Tanzania

6 ASCENSION ISLAND 1958 - Ascension Island

7 ASTRO BEACON “E” - Iwo Jima Island

8 AUSTRALIAN GEODETIC 1966 - Australia, Tasmania Island

9 AUSTRALIAN GEODETIC 1984 - Australia, Tasmania Island

10 ASTRO DOS 71/4 - St. Helena Island

11 ASTRONOMIC STATION 1952 - Marcus Island

12 ASTRO B4 SOROL ATOLL - Tern Island

13 BELLEVUE (IGN) - Efate and Erromango Islands

14 BERMUDA 1957 - Bermuda Islands

15 BOGOTA OBSERVATORY - Colombia

16 CAMPO INCHAUSPE - Argentina

17 CANTON ASTRO 1966 - Phoenix Islands

18 CAPE CANAVERAL - Florida, Bahama Islands

19 CAPE - South Africa

20 CARTHAGE - Tunisia

21 CHATHAM 1971 - Chatham Island (New Zealand)

22 CHUA ASTRO - Paraguay

23 CORREGO ALEGRE - Brazil

24 DJAKARTA (BATAVIA) - Sumatra Island (Indonesia)

25 DOS 1968 - Gizo Island (New Georgia Islands)

26 EASTER ISLAND 1967 - Easter Island

27 EUROPEAN 1950 - Austria, Belgium, Denmark, Finland, France, Germany, Gibraltar, Greece,
Italy, Luxembourg, Netherlands, Norway, Portugal, Spain, Sweden, Switzerland

28 EUROPEAN 1979 - Austria, Finland, Netherlands, Norway, Spain, Sweden, Switzerland

29 FINLAND HAYFORD 1910 - Finland

30 GANDAIJIKA BASE - Republic of Maldives

31 GEODETIC DATUM 1949 - New Zealand

32 ORDNANCE SURVEY OF GREAT BRITAIN 1936 - England, Isle of Man, Scotland,
Shetland Islands, Wales

33 GUAM 1963 - Guam Island

34 GUX 1 ASTRO - Guadalcanal Island

35 HJORSEY 1955 - Iceland
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36 HONG KONG 1963 - Hong Kong

37 INDIAN - Bangladesh, India, Nepal

38 INDIAN - Thailand, Vietnam

39 IRELAND 1965 - Ireland

40 ISTS 073 ASTRO 1969 - Diego Garcia

41 JOHNSTON ISLAND 1961 - Johnston Island
42 KANDAWALA - Sri Lanka

43 KERGUELEN ISLAND - Kerguelen Island
44 KERTAU 1948 - West Malaysia, Singapore
45 L.C. 5 ASTRO - Cayman Brac Island

46 LIBERIA 1964 - Liberia

47 LUZON - Mindanao Island

48 LUZON - Phillippines (excluding Mindanao Island)
49 MAHE 1971 - Mahe Island

50 MARCO ASTRO - Salvage Islands

51 MASSAWA - Eritrea (Ethiopia)

52 MERCHICH - Morocco

53 MIDWAY ASTRO 1961 - Midway Island

54 MINNA - Nigeria

55 NORTH AMERICAN 1927 - Alaska

56 NORTH AMERICAN 1927 - Bahamas (excluding San Salvador Island)

57 NORTH AMERICAN 1927 - Central America (Belize, Costa Rica, El Salvador, Guatemala,
Honduras, Nicaragua)

58 NORTH AMERICAN 1927 - Canal Zone
59 NORTH AMERICAN 1927 - Canada (including Newfoundland Island)

60 NORTH AMERICAN 1927 - Caribbean (Barbados, Caicos Islands, Cuba, Dominican
Republic, Grand Cayman, Jamaica, Leeward Islands, Turks Islands)

61 NORTH AMERICAN 1927 - Mean Value (CONUS)

62 NORTH AMERICAN 1927 - Cuba

63 NORTH AMERICAN 1927 - Greenland (Hayes Peninsula)
64 NORTH AMERICAN 1927 - Mexico

65 NORTH AMERICAN 1927 - San Salvador Island

66 NORTH AMERICAN 1983 - Alaska, Canada, Central America, CONUS, Mexico
67 NAPARIMA, BWI - Trinidad and Tobago

68 NAHRWAN - Masirah Island (Oman)

69 NAHRWAN - Saudi Arabia

70 NAHRWAN - United Arab Emirates

71 OBSERVATORIO 1966 - Corvo and Flores Islands (Azores)
72 OLD EGYPTIAN - Egypt

73 OLD HAWALIIAN - Mean Value

74 OMAN - Oman
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75 PICO DE LAS NIEVES - Canary Islands

76 PITCAIRN ASTRO 1967 - Pitcairn Island
77 PUERTO RICO - Puerto Rico, Virgin Islands
78 QATAR NATIONAL - Qatar

79 QORNOQ - South Greenland

80 REUNION - Mascarene Island

81 ROME 1940 - Sardinia Island

82 RT 90 - Sweden

83 PROVISIONAL SOUTH AMERICAN 1956 - Bolivia, Chile, Colombia, Ecuador, Guyana,
Peru, Venezuela

84 SOUTH AMERICAN 1969 - Argentina, Bolivia, Brazil, Chile, Colombia, Ecuador, Guyana,
Paraguay, Peru, Venezuela, Trinidad and Tobago

85 SOUTH ASIA - Singapore

86 PROVISIONAL SOUTH CHILEAN 1963 - South Chile
87 SANTO (DOS) - Espirito Santo Island

88 SAO BRAZ - Sao Miguel, Santa Maria Islands (Azores)
89 SAPPER HILL 1943 - East Falkland Island

90 SCHWARZECK - Namibia

91 SOUTHEAST BASE - Porto Santo and Madeira Islands
92 SOUTHWEST BASE - Faial, Graciosa, Pico, Sao Jorge, and Terceira Islands (Azores)
93 TIMBALALI 1948 - Brunei and East Malaysia (Sarawak and Sabah)
94 TOKYO - Japan, Korea, Okinawa

95 TRISTAN ASTRO 1968 - Tristan da Cunha

96 User defined earth datum

97 VITI LEVU 1916 - Viti Levu Island (Fiji Islands)

98 WAKE-ENIWETOK 1960 - Marshall Islands

99 WORLD GEODETIC SYSTEM 1972

100 WORLD GEODETIC SYSTEM 1984

101 ZANDERIJ - Surinam

102 CH-1903 - Switzerland

103 Hu - Tzu - Shan

104 Indonesia 74

105 Austria

106 Potsdam

107 Taiwan - modified Hu-Tzu-Shan

108 GDA - Geocentric Datum of Australia

109 Dutch
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APPENDIX B: BINARY PHASE OUTPUT FORMAT

In binary phase output mode, GPS 18 series products will transmit two types of packets once per second.
One record contains primarily post-process information such as position and velocity information. The
second record contains receiver measurement information. For the GPS 18 PC and LVC, the records are
sent at a default baud rate of 9600 baud, 8 data bits, and no parity.

To turn these records on for the PC and LVC versions, use the $PGRMC1 NMEA sentence as described in
Section 4 GPS 18 PC and GPS 18 LVC Software Interface. (Refer to the GARMIN GPS Interface
Specification for details on how to form and parse Garmin packets. At the time of this printing, these specs
are available from the technical suppport section of our Web site:

http://www.garmin.com/support/commProtocol.html.)

For the GPS 18 USB, the two records must be enabled independently by commands to the unit (Refer to the
GARMIN GPS Interface Specification USB Addendum for details on how to form and parse Garmin
packets over USB. At the time of this printing, these specs are available from the technical suppport section
of our Web site: http://www.garmin.com/support/commProtocol.html.) The ID of each command should
be 10 decimal to signify that the record is a command. The data portion of the packet should be one of the
following:

Function Command (base 10)
Position Record On 49
Position Record Off 50
Receiver Measurement Record On 110
Receiver Measurement Record Off 111

Note that the satellite data information is also enabled when the position record is enabled.

Records sent over RS232 begin with a delimiter byte (10 hex). The second byte identifies the record type
(33 hex for a position record, 34 hex for a receiver measurement and 72 hex for a satellite data record).
The third byte indicates the size of the data. The fourth byte is the first byte of data. The data is then
followed by a checksum byte, a delimiter byte (10 hex), and an end-of-transmission character (03 hex).
Additionally, any DLEs (0x10) that appear between the delimeters are escaped with a second DLE. There
is sample code at the end of this section that will strip off the DLEs and ETXs.

RS232 Packet:

- 0x10 (DLE is first byte)

- Ox## (Record ID - single byte)

- Ox## (Number of data bytes — single byte)

- data bytes (See descriptions below)

- Ox## (2’s complement of the arithmetic sum of the bytes between the delimiters)
- 0x10 (DLE)

- 0x03 (ETX is last byte)

USB packets contain only the record ID, size, and data payload. Refer to the GARMIN GPS Interface
Specification USB Addendum for details on how to form and parse Garmin USB packets.

USB Packet:

- Ox## (Record ID — single byte)

- Ox## (Number of data bytes — single byte)
- data bytes (See descriptions below)

The data bytes of each packet contain the record specified by the record ID. A description of each record
follows.
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Satellite Data Record

The satellite data has a record ID of 0x72 with 84 (0x54) data bytes. The data bytes contain the data for the
12 channels as described below. For each satellite, the following data is available:

typedef

struct

{

uint8 svid,; /Ispace vehicle identification (1-32 and 33-64 for WAAS)
uintl6 snr; //signal-to-noise ratio

uint8 elev; //satellite elevation in degrees

uint16 azmth; //satellite azimuth in degrees

uint8 status; //status bit-field

} cpo_sat_data;

The status bit field represents a set of booleans described below:

Bit Meaning when bit is one (1)
0 The unit has ephemeris data for the specified satellite.
1 The unit has a differential correction for the specified satellite.
2 The unit is using this satellite in the solution.

This pattern is repeated for all 12 channels for a total of 12 X 7 bytes = 84 (0x54) bytes :

typedef

struct

{

cpo_sat data
cpo_sat data
cpo_sat data
cpo_sat data
cpo_sat data
cpo_sat data
cpo_sat data
cpo_sat data
cpo_sat data
cpo_sat data
cpo_sat data
cpo_sat data

} cpo_all sat data

The RS-232 Packet for the Satellite Record looks like:

- 0x10
- 0x72
- 0x54

(DLE is first byte)
(Record ID — single byte)
(Number of data bytes — single byte)

- cpo_all sat data

- Ox#t
- 0x10
- 0x03

(2°s complement of the arithmetic sum of the bytes between the delimiters)

(DLE)
(ETX is last byte)
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The USB Packet for the Satellite Record looks like:
- 0x72 (Record ID — single byte)

- 0x54 (Number of data bytes — single byte)

- cpo_all sat data

Position Record

The Position Record has a record identifier of
t ypedef struct

{

fl oat alt;

fl oat epe;

fl oat eph;

fl oat epv;

i nt fix;

doubl e gps_t ow,
doubl e | at;
doubl e | on;

fl oat | on_vel;
fl oat | at _vel;
fl oat alt_vel;
fl oat nmsl _hght;
i nt | eap_sec;
| ong gr m_days;

} cpo_pvt _dat a;

alt Ellipsoid altitude (meters)

epe Est pos error (meters)

eph Pos err, horizontal (meters)

epv Pos err, vertical (meters)

fix 0 =no fix; 1 = no fix; 2 = 2D; 3 = 3D; 4 = 2D differential; 5 = 3D differential,

6 and greater - not defined
gps_tow GPS time of week (sec)

lat Latitude (radians)

lon Longitude (radians)

lon_vel Longitude velocity (meters/second)
lat_vel Latitude velocity (meters/second)
alt vel Altitude velocity (meters/second)

msl_hght  Mean sea level height (meters)
leap_sec UTC leap seconds
grmn_days Garmin days (days since December 31, 1989)
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Receiver Measurement Record

t ypedef struct

{

unsi gned | ong cycl es;
doubl e pr;

unsi gned int phase;
char sl p_dtct;
unsi gned char snr_dbhz;
char svi d;
char val i d;

} cpo_rcv_sv_data;

t ypedef struct
doubl e rcvr_tow,
i nt rcvr_wn;
cpo_rcv_sv_data sv[ 12 ];

} cpo_rcv_data;

revr_ tow  Receiver time of week (seconds)

rcvr_wn Receiver week number

cycles Number of accumulated cycles

pr Pseudorange (meters)

phase To convert to (0 -359.999) multiply by 360.0 and divide by 2048.0

slp_dtct 0 = no cycle slip detected; non-zero = cycle slip detected
snr_dbhz  Signal strength - db Hz

svid Satellite number (0-31 and 119-138 for WAAS) Note - add 1 to offset to current svid
numbers.

valid 0 = information not valid; non-zero = information valid
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DLE and ETX bytes:
Sample C code to receive the two records should filter DLE and ETX bytes as described below:
t ypedef enum

{

DAT,

DLE,

ETX

} rx_state_type;

/* Declare and initialize static variables */
static char i n_que[ 256 ];

static int in_que_ptr = 0;

static rx_state type rx_state = DAT,

void add_to_que( char data )

{
#define DLE_BYTE 0x10

#defi ne ETX_BYTE 0x03
if ( rx_state == DAT )

{
if ( data == DLE BYTE )

{
rx_state = DLE;

}

el se

{

in_que[ in_que_ptr++ ] = data;

}
else if ( rx_state == DLE )

{
if ( data == ETX_BYTE )

{

rx_state = ETX;

}

el se

{

rx_state = DAT,

in_que[ in_que_ptr++ ] = data;
}

}
else if ( rx_state == ETX)

{
if ( data == DLE BYTE )

{
rx_state = DLE;

}
if ( in_que_ptr > 255)

in_que_ptr = 0;
}
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APPENDIX C: GPS 18 PC/LVC AND WINDOWS SERIAL MOUSE ISSUE

Problem: It is possible for Windows to incorrectly interpret the NMEA 0183 output of the GPS 18 PC as
the output of a Microsoft Serial BallPoint Mouse. When that happens, Windows loads drivers for the Serial
BallPoint Mouse. This causes the cursor to move erratically about the display, clicking, right clicking,
double clicking, dragging and dropping displayed items as it goes. On Windows 2000 and Windows XP,
you may not experience the problem if you wait until after the computer is booted before connecting the
GPS 18 PC to the serial communications port. This problem is not specific to the GPS 18 PC. Any NMEA
0183 device connected to a Windows computer’s serial port is likely to cause this problem. Below are
several possible solutions to this problem.

Note: If your GPS 18 PC came with Garmin nRoute™ Navigation Software, you will not have this
problem because the unit is programmed to produce data according to the binary format that is described in
Appendix B: Binary Phase Output Format.

If you wish to use a different navigation software application with your GPS 18 PC, you will need to de-
select the “Phase Output Data” option that is discussed in Solution 3 below.

Solution 1: The easiest solution is to disable the Serial BallPoint mouse in the Device Manager. Of course,
this solution assumes that you do not need to use a Serial BallPoint mouse with your computer. When the
wild mouse problem occurs follow the steps below.

1.  Unplug the DB9 connector.

2. Right-click on the My Computer icon on your desktop and select Properties to open Device Manager
3. Go to the hardware tab of the resulting pop-up window and click on the Device Manager button.

4. Right-click on the Serial BallPoint Mouse and choose the option to disable (NOT uninstall) this device.

Solution 2: Do not plug the DB9 connector into the computer until the computer is turned on and the
operating system is completely booted up and running. Every time you use the GPS 18 PC/LVC, you will
need to start the computer and operating system before making the connection between the GPS 18 PC and
the computer. This solution usually works on Windows 2000 and Windows XP computers.

Solution 3: Change the default output of the GPS 18 PC/LVC so that it does not automatically send NMEA
0183 data to the computer (change the default configuration to enable “Phase Output Data”). Use the
Garmin Sensor Configuration Software, named SNSRCFG.EXE, provided on the Web site to enable
“Phase Output Data.” SNSRCFG.EXE is included with the latest GPS 18 firmware, available at
http://www.garmin.com/support/agree.jsp?product=010-00321-05.

Please note that by enabling “Phase Output Data,” the device will no longer appear as a NMEA 0183
device to your computer. As a result, mapping applications that expect to hear NMEA 0183 data will not
recognize your GPS 18 P/LVC until you re-enable the NMEA 0183 output, disabling the “Phase Output
Data” in the process.

Refer to Appendix D: Sensor Configuration Software for complete information about downloading the
Sensor Configuration Software application.

After the Sensor Configuration Software is installed and running on your computer, follow the steps below
to change the default data output of the GPS 18 PC or LVC.

1. Select the GPS 18 PC / LVC from the list of sensors and
click OK. The Sensor Configuration Software opens with

the default configuration file for the GPS 18, as shown on ~Base Model
the next page. \which Garmin " GPS 1§
. FENSOr are you i GPS 15 H/L
2. Select Config > Switch to NMEA Mode (or press the cornecting to? o
F10 key). " GPS 1617
3. Select Comm > Setup to open the Comm Setup Window. O GRS N
& GPS18PC /LWC
" GPS 25/35/36
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Select the Serial Port to which
the GPS 18 is connected. Select
Auto to have the program
automatically determine the
Baud Rate, or select Manual to
manually select the Baud Rate of
the GPS 18. Click OK when
done.

x
Serial Part: Baud Rate
oM I i+ Auto
= Manual
ak. I Cancel |

10.

11.

. . FEr
Click the Connect icon 2%, or
select Comm > Connect to
connect to the GPS 18.

To view the current
programming of the GPS 18,
select Config > Get
Configuration from GPS (or
press the F8 key). The current

programming of the GPS 18 is displayed in the window, as shown on the previous page.

Configuration.

-lalx
File Comm Config Wiew Help -
([ 83| = S
Configuration file: SNIRCFG
GPS Base Model: GP3 18 PC / LVC
Selected
Latitude: 0o0® od.0o00' o Sentences:
Longitude: 0oo® oo.oo00' E GRGGL
Altitude: 300.0 mweters GPGSA
GRGEV
Fix mode: Automatic GPRMC
Filter mode: automatic PGRME
Baud rate: 4500 hbps FGRME
Dead Reckon Time: 30 sec PGEMT
HMEA Output Time: 1 sec
Position Averaging: Off
HMEA 2.30 Mode: Off
Power Save Mode: Off (Mormal Mode)
PP5 mode: 1 H=
PPS Length: 100 msec
Phase Output Data: Off
DLPS Mode: WiLS Only
Differential mode: Automatic
Earth datum index: WEE G54
v
Open the Sensor Configuration Window by pressing the F6 key or selecting Config > Sensor
x|

Place a check mark in the box next to “Binary
Output Data” to change the GPS 18 to GARMIN
Mode. The unit will keep this change in the
programming until you change it again in the

software.

Note: Selecting Config > Switch to Garmin
Mode (or pressing the F11 key) only changes the
unit to work in Garmin Mode until power is
cycled through the unit again. For a more
permanent change, refer to step 8 above.

Click OK when completed enabling “Binary

Output Data.”

When you are ready to upload the changes into the

Altitude:

Fix Mode: IAutomatic 'I

Differential Made

Earth Dratum: 4

Latiude: [0 " 0 AN OIS e
Longtuds [0 [0 'GE W oE

300 meter

Baud Rate:

GPS 18, select Config > Send Configuration to

GPS (or press the F9 key). The new configuration

is then loaded into the GPS 18.

You may disconnect and close the software when
finished. The software configuration can also be

saved for future reference.

— Baze Model
[ Automatic i O EE R (o
P - GRS AL
Welocity Filker: I.-’-‘«utomatll: vl =
GRS 1EL
¥ Pulze PerSecond [ Position &veraging 1 GRS AR,
I~ Phase Output Data |~ NMEA 230 Mode | & CFo 171
& GPS 18 PC A LYE
Dead Reckon  MMES output GRS 25 S5 R
Yalid Time time FFS Length -

El I
DGEPS Mode: IWAASDnI_I,J 'l

et

IES?S‘I 37
|298.25?223583

= Beacan Statian

FDreg: -

™| St Tiure o Loss

it Hiates

. . Eeset kit | Heset NDnVDIl
Refer to Appendix D: Sensor Configuration Software I™ Power Save Mode
for complete information about downloading the et Autolooate] | Testhode | o | cancel |
Sensor Configuration Software application.
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APPENDIX D: SENSOR CONFIGURATION SOFTWARE

SNSRCFG configures the GPS sensors based on user-selected parameters. Some application features
include the ability to download GPS sensor configuration, maintain different configurations in files, and
perform GPS sensor configurations quickly with the use of one function key.

This section provides a brief overview of the Sensor Configuration Software. Refer to this section when

using the software to configure your Garmin sensor.

Downloading the Sensor Configuration Software
The Garmin Sensor Configuration Software (SNSRCFG.exe) is ~ Base Madel
available from the Garmin Web site. To download the software, start , ,  Gps s

. Which G armit 2
at http://www.garmin.com/oem, select the GPS 18, and then select SEnsar are you GRS 15HL
Software Updates. The Garmin Sensor Configuration Software el pulal GRS 1EA
(SNSRCFG.exe) is included in the software update download. " GPS16A17

GRS 17N
. & GPS 18 PC /LY

Selectlng a Model '  GPS 25/%/%
After opening the program (snsrcfg.exe), the following screen

appears. Select the radio button next to the type of Garmin sensor you

are configuring.

Connecting to the Sensor

After selecting the type of sensor, the following window opens. This is the Main Interface Screen for the

program.

To configure your sensor, you must first connect to the sensor.

) x
1. Select Config > Switch to NMEA Mode (or press the F10 key). =
Senial Port: Baud Fate
2. Select Comm > Setup to open the Comm Setup Window. ' huto
" Manual
3. Select the Serial Port to which the sensor is connected. Select Auto
to have the program automatically determine the Baud Rate, or ok | Cancel |
select Manual to manually select the Baud Rate of the GPS 18.
Click OK when done.
. . Lel 2]
4. Click the Connect icon 2%l or
seloot Comm > Connect =i
Eile Comm Config Yiew Help -
5. To view the current programming - ap| =1
== el M= N=
of the sensor, select Config > Get =] 2] % —l —I
Conﬁguratlon from GPS (OI‘ Configuration file: SN3RCFG
press the F8 key). The current GP5S Base Model: GPS 18 PC / LVC
programming of the sensor is Selected
displayed in the window shown to LatlFude: ao® oo.ooo' W Sentences:
. Longitude: 000° 00.000' E GPGGL
the right. Altitude: 300.0 meters GPGSA
GPGEV
. Fix mode : butomatic GPRMC
File Menu Filter mode: Lutomatic PGRME
The File Menu allows you to open, Baud rate: 4800 hps PGRHE
. . Dead Reckon Time: 30 sec PGEMT
save, and print sensor conﬁguratlops. HMEA Output Time: 1 sec
The items in the File Menu work like Position Averaging: Off
HMEA 2.30 Mode: Off

most Windows-based programs.

Power Save Mode:

Off [Mormal Mode)

PP5S mode: 1 H=

PPS Length: 100 msec
Phase Output Data: Off

DGPS Mode: WLLS Only
Differential mode: butomatic
Earth datum index: mrs 54
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Comm Menu

The Comm (Communication) Menu allows you to set the port number, baud rate, and then connect and

disconnect from the sensor.

Setup: Opens the Comm Setup Window, shown to the left. Select

the Serial Port to which the sensor is connected from the drop-
down list. Then select Auto (the program determines the baud rate
on its own) or Manual (you then enter the baud rate) for the Baud

Connect: Select Connect to connect to the sensor to change or

Disconnect: Select Disconnect to disconnect from the sensor.

x
Serial Part: Baud Fate
- ¢ Auto
" Manual Rate entry.
[].8 Cancel |
view the configuration.
Config Menu

The Config (Configuration) Menu allows you
configure the sensor as it is connected.

Sensor Configuration (F6): Opens the Sensor
Configuration Window, shown to the right. Many of
the fields in this window should be left alone. Please
refer to the beginning of this manual for clarification
about some of these fields. For the most part, this
window is used to enter a new Latitude, Longitude,
and Altitude for the sensor. This is especially helpful
when you are programming the sensor for use in a
particular geographic location.

Resetting the Unit (Reset Unit) performs a reset on the
unit, much like cycling the power.

Resetting the non-volatile memory (Reset NonVol)
will clear all of the data from the non-volatile memory.

NMEA Sentence Selections (F7): Displays the
NMEA Sentence Selections Window. If the sentence is
enabled, a check mark appears in the box to the left of
the sentence name. Click the box to enable or disable
to the sentence.

NMEA Sentence Selections

— Selections

V¥ GPGGA
¥ GPGS&
V¥ GPGSY
v GPRMC
I~ GPYTG
[~ LEGEL
I LT

I
I~ PGRME
[~ PGRMF
[~ PGRMT
I~ PGRMY
[~ PGRMM
I~ GPGLL oK

Reset...

Cancel

HllEE

Sensor Configuration

Earth Dratum:

Latiude: [38 | 513308 | N 8
Longiude [34 | [s73322 ' C E

3242 meter
Fix Mode: IAutomatic 'I

Differential Made

Altitude:
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Get Configuration From GPS (F8): Retrieves the current programming from the sensor. The
programming is then displayed in the Main Interface Window.

Send Configuration To GPS (F9): Sends the changes you have made to the programming to the sensor.

Switch to NMEA Mode (F10): Switches the unit to NMEA Mode. The sensor must be in NMEA Mode
when connected to this software.

Switch to Garmin Mode (F11): Switches the unit to Garmin Mode.

Update Software (F12): After you have downloaded a new software version for the sensor, you can update
the sensor with the new software. Select Update Software and then select the file using the Open dialog
box. You must locate both the *.rgn file and the updater.exe file.

View Menu
The View Menu allows you to view the NMEA sentences transmitted by the sensor. You can also
customize how the program looks by showing and hiding the Toolbar and Status Bar.

Help Menu

The Help Menu displays the software version and copyright information.

For the latest free software updates (excluding map data) throughout the life of your
Garmin products, visit the Garmin Web site at www.garmin.com.
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